STANFORD UNIVERSITY SELF-EXTRACTING INSTALLER

I Mac M Windows

STANFORD UNIVERSITY SELF-

EXTRACTING INSTALLER (SUSEI)

OVERVIEW

The Stanford University Self-Extracting Installer (SUSEI) is a program that creates self-extracting single exe
files. The files that SUSEI creates can then be downloaded from a web page and executed. Once executed,
the program will extract all of the files that it contains into a temporary directory, execute a pre-defined
program with any command line parameters that have been defined, then delete the temporary files when
the program that is executed ends.

SUSEI reads and writes self-extracting file project files (.bwdProj) that contain all the information needed to
rebuild the self-extracting file. When the self-extracting file must be updated (for example, if a new version
of the program that is being installed becomes available), generating a new self-extracting installer file is
simply a matter of replacing the program installer files, loading the .bwdProj file in SUSE], and clicking on
“Build Installer”.

REQUIREMENTS

Windows XP or Windows Vista

WinZip Professional (http://www.winzip.com/prodpagewz.htm)

WinZip Self-Extractor (http://www.winzip.com/prodpagese.htm)

WinZip Command Line Support Add-On (http://www.winzip.com/prodpageclLhtm)
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STANFORD UNIVERSITY SELF-EXTRACTING INSTALLER

MAIN WINDOW

When SUSEI is launched, the main window below is displayed.

" Stanford University Se actor Installer [Version Z.20.0 Final}

File Edit Help

SR B @ 8 s

Open  Save Build | “iew Installer Files TestInstaller | Clear Status Exit

Project Settings
"Files" Directory (files to be indluded in the Self-Extractor Installer file):

Browse...

File in the directory above to run: v] Using
environment

Optional command line parameters: variable paths

Name of Web Installer file to create: This project
does not
[F] Include Hidden and Read-Only files in the Web Installer file .

Include Subdirectories and Files in the Web Installer file comments.
Delete Temp Files After Install

[ Use Relative Paths for This Project

[T Use Enviranrnent Variable Paths for This Project

NOTE: The Installer will be placed in the ZIP directory parent directory.

Web Installer File

Browse...

(88 28 22 28)

Program Status

This is the windows where you define all of the parameters that SUSEI will use to create the self-extracting

installer file.
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| SETTINGS

This section contains the information necessary for SUSEI to create the self-extracting installer file.

- “FILES” DIRECTORY

“Files" Directory (files to be included in the Self-Extractor Installer file):

Browse...

This refers to the directory that contains the files that will be extracted to a temporary directory when the
self-extracting installer is executed. You can click on the “Browse...” button to navigate to the directory
using a standard Windows directory browser dialog box.

:FILE IN THE DIRECTORY ABOVE TO RUN:

File in the directory above to run: -

Once you have selected a directory, this dropdown box will contain all executable files in the selected
directory. Select a file that will be executed after the files are extracted to a temporary directory.

If you are distributing a package that contains both 32 bit and 64 bit installers, specify the 32 bit executable,
and make sure that the 64 bit executable is located in the same directory, and named
32BitExeBaseName64.exe. Here are a couple of examples:

32 Bit Executable 64 Bit Executable
Setup.exe Setup64.exe
InstallerWrapper.exe InstallerWrapper64.exe

At runtime, after your package is extracted, if the operating system is Win 64, SUSEI will look for the 64 bit
executable. If SUSEI finds a 64 bit executable, it will run it rather than the one specified in the "File in the
directory above to run:" dropdown box.

-OPTIONAL COMMAND LINE PARAMETERS:

Optional command line parameters:

If the program that will be executed requires command line parameters, enter those command line
parameters here.

Some setup.exe files require the /SMS command line parameter to be successfully executed from SUSEIL
Since SUSEI will delete all of the temporary files when the launched executable ends, a premature end to
that executable will cause the installer to fail. Many setup.exe files will end as soon as the actual installer is
launched by setup.exe. The /SMS command line parameter forces setup.exe to remain running until the
installer that it launches ends. You can also choose to uncheck the "Delete Temp files After Install" check
box, but this means that the files will remain on the user's PC in the temporary directory until the user
deletes them.
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:NAME OF WEB INSTALLER FILE TO CREATE:

Mame of Web Installer file to create:

SUSEI will create a self-extracting executable with this name, and it will be placed in the parent directory of
the directory that contains the files (“Files” Directory).

_INCLUDE HIDDEN AND READ-ONLY FILES IN THE WEB INSTALLER FILE
[ Include Hidden and Read-Only files in the Web Installer file

If this checkbox is checked, all files in the “Files” Directory (even hidden files and read-only files) will be
included in the self-extracting executable. Leave this unchecked unless there is a reason to include these
types of files. If you check this box SUSEI might not be able to delete the files from the temporary directory
after the installer ends.

INCLUDE SUBDIRECTORIES AND FILES IN THE WEB INSTALLER FILE

Include Subdirectories and Files in the Web Installer file

If the “Files” Directory contains subdirectories and files that are required by the “File in the directory above
to run:” executable, check this checkbox. SUSEI will re-create the directory structure in the temporary
directory before the installer is executed.

DELETE TEMP FILES AFTER INSTALL
Delete Temp Files After Install
If you uncheck this box, then SUSEI will not delete the extracted files from the temp directory after the

install has completed. This might be useful if you need to troubleshoot an installer. In general however,
you should keep this checked to avoid leaving files on user’s computers that are unnecessary.

-USE RELATIVE PATHS FOR THIS PROJECT
[] Use Relative Paths for This Project

You can override the global relative path setting for the current project by checking this checkbox.

-USE ENVIRONMENT VARIABLE PATHS FOR THIS PROJECT

[ Use Environment Variable Paths for This Project

You can override the global environment variable path setting for the current project by checking this
checkbox.
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XS

BUILD INSTALLER BUTTON | Build

Clicking on this button (or selecting “Build Installer” from the File Menu), will use all of the information
that has been entered on this window, and in the Global Settings window (see the "Options" section for
more information) to create the self-extracting executable.

WEB INSTALLER FILE

This section refers to a self-extracting executable that was created by SUSEIL. Immediately after a
successful build, the full path to the file that was built will be displayed here. Once a valid exe file is

e @
displayed in the text box, the “View Installer Files” "= "™#€Fles 51 d “Test Web Installer” TestInstaller

buttons will be enabled. You can also Browse to another file that has been created by SUSEI by clicking
on the Browse button to designate a web installer file.

-PRODUCT VERSION

You set this to the version number of the program that you are installing. By doing this, you can right
click on the web installer file that you create and examine the version number to see what version of the
program will be installed by the file.

If you enter a version here, SUSEI will change the exe Product Version when the installer is successfully
built. Example:
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|} SuSophoslnstaller.exe Properties ;l‘
General | Compatibility | Digital Signatures
Security | Details | Previous Versions
Property Value
Description
File description  Stanford University Self Bdracting Installer
Type Application

Product name  WebDownload Application

Copyright Copyright (C) 2007 Stanford University
Size 464 MB

Date modfied 12712008 2:23 FM

Language English (United States)

‘ File wversion 1.00.8
I

Remove Properties and Personal Information

| oK || Ccancel Apply
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éVIEW FILES IN INSTALLER

Clicking on this button will extract the WinZip created zip file and display it in the WinZip Window.

Example:
-;l WinZip Pro - SuseiTempFile.exe o [ m] |
File Actions Wiew Jobs Options  Help
- '.l [ = | \ [ |\ o -ﬁ\ { 3 s ) 1
q &:ﬂnlg | @ |':::H-..- |g§ & U»:ﬁ w @ w‘
-} kb b B X B L LN = A
Mew Open Favorites Add Extract Ercrypt Wiew Inskall Wizard
Marne | Type | IModified | Size | R.atio | Packed | Path
[TRunSusIT exe Application 17102008 12:04 PM a6,016  53% 40,528
SustainableIT.exe  Application 11142008 8:20 AM 4,308,039 70% 1,308,...

1

|Selected 0 files, 0 bytes

Total 2 files, 4,292KE

: TEST INSTALLER

Clicking on this button will display a window that will ask for additional information, and then execute
the file that is displayed in the “Web Installer File Actions” text box. The window that will be displayed

is:

¥ Optional Command Line Parameters

Enter com mand line parameters that will be passed to the program

=10l

L* 4

[ silentWrapper Switch

wok |

Cancel |

In addition to the command line parameters that were specified in the “Optional Command Line
Parameters” text box (which is built into the self-extracting executable itself), the self-extracting zip file
can also accept addition command line parameters from the command line. These parameters, plus any
that were defined in the “Optional Command Line Parameters” text box will be passed to the file that
was specified in the “File in the directory above to run:” dropdown box.

The resulting self-extracting executable will display a splash screen unless the "Silent Wrapper Switch"
check box is checked. Example of the splash screen:
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|

‘ PROGRAM STATUS

This section will display a log file of all program activity. If the program is unable to perform certain
actions, error messages will be displayed here. Example:

~Program Status

ChlsersitonysilhAppDatatlocal\Termph~WebDownload, exe ;I
1 fileis) copied, ]

[3/1952008 9:30 AM] Error # -1 returned from SIGNCODE.EXE (Error: TimeStarnping Failed, Result =
annvonnea, (-2147024890)
il

=l

Clear Status Text |

-

Clicking on the “Clear Status” “'¥2"%#%= bytton will delete all log messages from the status text box.

MENU ITEMS

_OPTIONS...

Selecting “Options...” from the Edit Menu will display the Global Options Window:
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ﬁ Global Preferences

[] Use Relative Paths Use Environment Variable Paths ﬁ
[¥] Sign the Weh Installer [/] Save Project after a Successful Build [¥] Open installer directory after build

SIGNCODEEXE Path

C:\Users\jdoe\Code\CodeSigning)\Bin\ SIGNCODE.EXE

Credential Path

ChUsers\jdoe\ Codeh\CodeSigning\WeriSignimycredentials.spc

Private Key Path

Chlsers\jdoe\Codel\ CodeSigning VenSigntmyprivatekey. pvk

Check for Updates:

Save ] [ Cancel ]

You can define variables here that will determine how SUSEI will create the self-extracting executable, how
file paths will be displayed in the SUSEI user interface, and how file paths will be saved to the .bwdProj
project file.

Note that some options are duplicated in the main window. If those options differ from the ones here, the
project specific settings (those in the main window) take precedence.

USE RELATIVE PATHS

If this check box is checked, SUSEI will save the paths specified in ““Files” Directory’ and “Web Installer File
Actions” to the .bwdProj file as paths relative to the location of the .bwdProj file.

For example, if the “Files” Directory’ is set to “C:\MyProjects\WeblInstallers\SustainableIT\Files”, and the
.bwdProj file is located in the “C:\MyProjects\Weblnstallers\bwdProjFiles\SustainableIT.bwdProj”, then
the path that is saved to the Sustainablel T.bwdProj for “C:\MyProjects\WeblInstallers\SustainableI T\ Files”
will be “..\SustainablelT\Files”.

Since only one path type can be saved to the project file, if “Use Environment Variable Paths” is checked
when “Use Relative Paths” is checked, “Use Environment Variable Paths” will be automatically unchecked.
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USE ENVIRONMENT VARIABLE PATHS

If this check box is checked, SUSEI will save the paths specified in “FILES” DIRECTORY and WEB INSTALLER
FILE ACTIONS to the .bwdProj file as paths that will have environment variables that have been defined in
the Environment Variable definition window substituted for the actual path.

For example, if the “FILES” DIRECTORY is set to “C:\MyProjects\Weblnstallers\SustainablelT\Files”, and
the environment variable “PROJECTS” as been set to “C:\MyProjects” , then the path that is saved to the
Sustainablel T.bwdProj for “C:\MyProjects\Weblnstallers\SustainableIT\Files” will be
“0%PROJECTS%\Weblnstallers\SustainableIT\Files”.

Since only one path type can be saved to the project file, if “Use Relative Paths” is checked when “Use
Environment Variable Paths” is checked, “Use Relative Paths” will be automatically unchecked.

If both “Use Relative Paths” and Use Environment Variable Paths” are unchecked, the the full absolute path
will be saved to the bwd.Proj file.

SIGN THE WEB INSTALLER

If this checkbox is checked, the remaining entry items on the window are enabled. SUSEI will sign the self-
extracting executable, if you check this check box, and enter all of the required code signing information
(Windows Authenticode).

SAVE PROJECT AFTER A SUCCESSFUL BUILD

If this checkbox is checked, SUSEI will automatically save the project file immediately after a successful
build.

OPEN INSTALLER DIRECTORY AFTER BUILD

If checked, the directory that contains the newly built self-extracting installer will be opened in
Windows Explorer.

CHECK FOR UPDATES

Select how often SUSEI will check the network for updates. Possible options are Daily, Weekly, Monthly,
or Never. Be aware that if you select Never, you will not be notified when a newer version of the
program becomes available. This option is not recommended.
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- DEFINE ENVIRONMENT VARIABLES...

Selecting “Define Environment Variables...” from the Edit Menu will display the following window:

i
Add Ervironment Wariahles to the "Saved Environment Wariables" list, The saved variables will be used to %
abstract project file paths, ﬁ

Existing Environment Yariables Saved Environment Variables
Marne | value | CODESIGN
MUNMBER_OF_PROCESSC 2 - C_CODE
s Windows MT o REALBASIC_CODE
Path ChProgram Files\Windows Resour.. CERT
PATHEXT {COM;:.EXE; BAT: CMD;.VBS, VBE,.J... Add USERPROFILE
PROCESSOR_ARCHITEC %86 D_TEMP
PROCESSOR_IDEMTIFL., =86 Farnily 13 Model 2 Stepping 9, ..
PROCESSOR_LEWVEL 15 Pl e |
PROCESSOR_REVISION 0209
ProgramData ChPrograrnData
PrograrmFiles C\Prograrm Files
PROMPT $PiG
PUBLIC CihdsershPublic
REALBASIC_CODE DnvCodetRealBasic
SESSIOMMAME Console
SysternDrive C
SysternPoot CMWindones
Tave G Do

If you choose to abstract file paths using environment variables, you can define which environment
variables will be used by SUSEI to abstract absolute paths from this window. Select the environment
variables that you want to use from the column on the left and press Add to add them to the list of Saved
Environment Variables. If you want to remove a variable, select it from the column on the right and press
“Remove”.

Using environment variables to abstract project paths is useful if you will be sharing the project with other
people. So, for example if two people will be working on the same SUSEI project on separate computers,
and they use different paths to store their project paths, using the same environment variables can make
sharing the SUSEI project easier. If user #1 keeps all of the project files in the "C:\MySuseiProjects" and
user #2 keeps the project files in "D:\SourceCode\SUSEI", and they agree to use %SUSEI% as the base path,
and the project directory is called "Weblnstaller", "%SUSEI%\Weblnstaller" would resolve to the following:

User #1: "C:\MySuseiProjects\Weblnstaller"

User #2: "D:\SourceCode\SUSEI\WeblInstaller"
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- COMMENTS...

Selecting comments from the menu will display a window where you can add comments to the project file.
Example:

& View/Edit Comments == B3
File Edit

I'I'his will install SUSEI and it's support files.
The latest version is stored on the web at:

hittp:/ fwww.stanford.edu/dept/its/projects/desktop
/internal_tool_versions/susei_ver.td

That file should be updated and the resulting
installer (InstallSusei.exe) should be copied to:

hittp:/ fwww.stanford.edu/dept/its/projects/desktop
/Susei/Installer/InstallSusei.exe

0K |

:RECENT PROJECT LIST...

Occasionally, the list of recently loaded projects that are listed in the “Open Recent” menu can get large or
may contain files that are no longer available. You can rearrange or delete these items by choosing “Recent
Project List...” from the Edit Menu.

- SUSEI COMMAND LINE PARAMETERS
You can script SUSEI by passing the program command line parameters.
SUSEI will accept two command line parameters:
/Build: and /Extract:

/Build: will cause SUSEI to build the self-extracting install by using the settings that re in the bwdProj file.
Examples:

Susei.exe /Build:"C:\MyProjects\TestInstaller\SelfExtract.bwdProj”

/Extract: will extract the files that are contained in the SUSEI-generated self extracting file that is specified
the path specified by the /TO: parameter. Example:

Susei.exe /Extract:”C:\MyProjects\TestInstaller\TestInstaller.exe:” /TO:"C:\Temp”

/Version: will set the Product Version of the web installer to the version specified on the command line.
Example:

Susei.exe /Build:"C:\MyProjects\TestInstaller\SelfExtract.bwdProj” /Version:"1.0.2.3"
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